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Introduction 

For a PDF to be considered ‘accessible’, it must be a ‘tagged’ PDF, meaning there must be a corresponding 
programmatic structure to the document. PDFs created from Microsoft Office programs, and many other 
software suites, can derive this structure from the authoring tool if they are exported correctly. Other PDFs, 
such as old content PDFs where the source document is no longer available, or scanned content PDFs, must be 
manually tagged.  

The goal of remediating a PDF is for the tag tree within the Tags Panel to match the document’s logical 
structure.   
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Exporting an Accessible PDF from Microsoft Office 

So long as accessibility best practices are followed when creating an Office document (see the district’s 
Website Accessibility Resources page for more guides tailored for each software suite), exporting to a tagged 
PDF can be as simple as selecting PDF as the file format when saving.   Be sure to keep the original in case 
further revisions are required. 

 

 

If given the option, ensure “Best for electronic 
distribution and accessibility” is selected. 

 

Users of Acrobat Pro may also have an Acrobat 
ribbon at the top of the Office software. If so, a 
tagged PDF can be created by going to the Acrobat 
ribbon and selecting “Create PDF.” 

 

OneDrive Method 

If uncertain of your configuration, you may use the OneDrive method to create a tagged PDF. 

1. Navigate to https://onedrive.live.com/ and log in using 
your OSD credentials. Note, if this is your first time 
using OneDrive, you may need to create an account.  

2. Select your Office document and drag it into your 
OneDrive folder. 

3. Once your document has finished uploading, right click 
it and select “Open in PowerPoint Online” or “Open in 
Word Online.” 

 

4. In the browser version of Word/PowerPoint, click File > 
Download As > Download as PDF. 

 
5. An alert box will appear reading “Your 

presentation is ready.” Click Download. 
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Acrobat Pro Accessibility Tools – Setting Up Your Workspace 

Accessibility Tools Pane 

The Accessibility Tools Pane within Acrobat Pro offers a suite of tools crucial to remediating a PDF. To display 
the Accessibility Tools Pane, go to View > Tools > Accessibility.  

The primary tools used for PDF remediation are: 

• Full Check – A thorough and versatile 
accessibility checker. 

• Add Tags to Document – Useful for 
remediating a PDF that was imperfectly 
created. This may be helpful when working 
with scanned documents, or documents 
that have been ‘printed’ to PDF. 

• Set Alternate Text – Useful for moving 
through all the images in a document and 
adding alternative text to them. 

• Touch Up Reading Order (TURO) – This is 
the primary tool in PDF remediation. It can 
be used to add or edit tags, as well as alter 
the reading order of the document.   

 

Tags Panel 

The Tags Panel displays the underlying 
programmatic structure of the document. To 
display the Tags Panel, go to View > Show/Hide > 
Navigation Panes > Tags. 

 

 

Read Order Panel 

The Read Order panel, sometimes referred to as 
the Z-Order panel, displays the reflow order of the 
document. This order is used when the document 
is opened on a mobile device and must be 
displayed in a more linear fashion. Some of the 
reading order for a screen reader is implied here, 
but it is not necessarily an accurate representation 
of the read order. That should be defined in the 
Tags Panel.  

To display the Z-Order panel, right-click the left 
tool bar and select Order. Alternatively, go to 
View > Show/Hide > Navigation Panes > Order. 
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Acrobat Pro Tools – Using Accessibility Tools  

Full Check 

The Full Check tool performs a thorough accessibility check, and highlights errors within the document. To 
perform a Full Check: 

1. Expand the Accessibility Tools Pane and 
select Full Check. 

 
2. The Accessibility Checker Options window 

will open. It is generally advised to use the 
default settings, so click Start Checking. 

  
3. The left pane will shift to the Accessibility 

Checker review. The number of potential 
issues is displayed alongside each issue 
category. Expand them using the arrows 
alongside each category type to see the 
individual issues. 

  

4. Right-clicking an issue will provide an 
additional menu with options to Fix, Skip 
Rule, Explain, or Check Again. Some errors, 
such as Title or Language, can easily be 
fixed using the Fix command. After 
repairing issues, it is necessary to select 
Check Again to update the report.   
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Add Tags to Document Using Acrobat’s Automatic Tool 

Acrobat can automatically add tags to untagged documents. Note, if you are starting from an accessible 
document that was correctly exported into a tagged PDF, this should not be necessary. Also, the tags Acrobat 
adds may not always be accurate and may require some correction later on using the Touch Up Reading Order 
Tool.  

1. Open the Tags Panel. If the Tags Panel is not 
displayed, go to View > Show/Hide > 
Navigation Panes > Tags. 
 

2. If “No Tags available” is displayed, your 
document lacks tags. Tags are necessary for 
a PDF to be accessible. 

  

 

3. Request Acrobat to automatically add tags to your document. This can be done either through the Tags 
Panel or the Accessibility Toolkit: 
 
Tags Panel: Select Options > Add Tags to 
Document 

 

Accessibility Toolkit: Click Add Tags to 
Document 
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Set Alternate Text 

This tool is the quickest way to add tags to images 
within the document. Users may make their way 
through each tagged image, adding alternative text 
for them. Simply enter alternative text in the 
Alternative Text field and select the right arrow to 
move to the next figure. 

Some figures may not serve a direct purpose and 
are purely decorative. If that is the case, select 
“Decorative figure” for that figure.  

   

Touch Up Reading Order (TURO) tool 

The Touch Up Reading Order Tool allows users to 
apply/edit tags in a document and modify the 
document’s reading order. It is the primary tool 
used in PDF remediation.  

To access it, go to Tools > Accessibility > Touch Up 
Reading Order. Note: If the Accessibility menu 
doesn’t display, go to View > Tools > Accessibility.  

When you open the TURO tool, your view will 
change. If your PDF is tagged, grey content area 
boxes will appear with numbers in the top left. 
These numbers signify the read order on that page. 
Users may instead analyze the tag types by 
selecting Structure Types rather than Page Content 
Order.  

If no content areas appear, your document is likely 
untagged. Tags can be manually added using the 
TURO tool, or added automatically using the Add 
Tags to Document tool.  

For more complex documents, such as complex 
forms or documents containing tables, ensure 
“Display like elements in a single box” is 
unchecked.  

 

 

 

Adding Tags to a Document Using the Touch Up Reading Order tool 

To tag an item using the TURO tool: 

1. Open the TURO tool. 
2. With the tool open, hovering your mouse over your document will display a crosshair. Using this 

crosshair, draw a box around your content element. A few notes: 
o The box must fully include the element. It will not register any content unless the element fits 

entirely within the square.  
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o As you draw selection zones, you may inadvertently select additional content. It is possible to 
add or remove content from your current select. This is particularly helpful when working with 
tables or forms.  

▪ Mac:  

• Add Content to selection: Shift-click to add content to the selection. 

• Remove content from selection: Option-click to remove content from the 
selection. 

▪ Windows: 

• Add content to selection: Shift-click to add content to the selection. 

• Remove content: Control-click to remove content from the selection. 
3. Once the element is highlighted, select the corresponding tag type from the TURO tool. Alternatively, 

right click the element and choose the correct tag from the menu.  

 

 

Tagging an Element as Decorative 

The TURO tool offers an option to tag an element 
as ‘background.’ This tag type effectively hides the 
element from the Tags Panel, and thus renders it 
inaccessible to screen reader users. This type of tag 
may be used for decorative elements, or for 
sections of blank lines.  

When considering if an element is decorative, ask 
yourself if additional information is included with 
the element, or if its removal will have any impact 
upon the content of the message.  
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Tags Panel 

Along with the Touch Up Reading Order tool, the Tags Panel is one of the most powerful accessibility tools in 
Acrobat Pro. It can be used to add, modify, reorder, or delete tags entirely.   

If ‘No Tags available” is displayed, the document is likely untagged and inaccessible. If possible, return to the 
source document, revise it as necessary, and export it as a PDF. If a source document is unavailable, use the 
Add Tags to Document tool in the Accessibility Tools Pane or manually tag the document using the Touch Up 
Reading Order tool.  

 

 

 

Elements within the document are nested within 
tags, much like in HTML. These tags can be revised 
using the Touch Up Reading Order tool, or through 
the Tags Panel itself.  
 

 

  

 

When working in the Tags Panel of a PDF, the goal is for elements to receive the appropriate tags and appear 
in a logical order. All content from the PDF must be tagged, though some decorative content may also be 
tagged as ‘background’ and will therefore not appear within the tag tree.  
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Rearranging Tags / Adjusting the Reading Order 

When clicking on an element within the tag tree, the corresponding content will be highlighted in the 
document. By using the arrow cursors to move down the tag tree, the document’s reading order can be 
ascertained.  

When dragging and dropping elements within the tag tree, there are two options for where to drop the 
element. You may either place it beneath an existing tag, or nest it within an existing tag. There is a small black 
arrow that shows where the dropped content/tag will appear: 

 

This paragraph will be nested within the H1 tag. 

 

This paragraph will be placed below the H1 tag. 

 

Editing Tag Type in the Tags Panel 

Some tags within the Tag Panel may be inaccurate and require revision. This may be a list that has been 
tagged as a paragraph etc. To alter the tag: 

1. Right-click the tag and select Properties. 

2. In the Object Properties menu, select the 
up/down arrows beside the Type field. Pick 
the correct tag type and select Close. 

Note: While it isn’t possible to revise multiple tags simultaneously, it can be done in quick succession. Simply 
do not close the Object Properties menu after selecting your tag type. Instead, click the next tag you would 
like to revise. The focus of the Object Properties menu will shift to the newly selected tag.  
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Adding Tags 

Occasionally when remediating a PDF, it is necessary to manually add a tag to the document tree. This is 
particularly helpful when repairing tables or lists. To add a tag: 

1. Right click within the Tag Pane where you want the new tag to appear.  
2. Select New Tag. 
3. Pick a tag type from the drop-down menu, or type in a tag type. Some tag types that don’t appear 

within the tag tree include: 

• THead – used for marking table rows as header rows. The row tag (<TR>) is nested within the 
tag.  

• TBody – used for marking rows as body rows. As above, the row tags are nested within the 
TBody tag.  

4. Drag content into the newly created tag.  

Text Recognition 

If your document is scanned or is simply an image of text, text recognition will need to be performed. If 
acquiring a non-scanned, or true-text, copy is possible, that is preferred. 

To run Text Recognition: 

1. On the right side of the screen, expand the 
Text Recognition menu and select In This 
File. 

 
2. Ensure All pages is checked, and select OK.  

 

Note: If some of the recognized text appears erroneous, you can use the Final All Suspects tool to perform 
corrections. 
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Remediating a PDF Using Acrobat Pro 

If possible, it is generally preferable to enhance the accessibility of the source document prior to exporting to 
PDF. This is because it is easier to modify a document in its authoring software than in Acrobat. 

If the source document is unavailable or the PDF is from scanned content, Acrobat Pro is required to 
remediate the document.  

Make Accessible Action Wizard 

One good way to begin the process of PDF remediation is to use the Make Accessible action wizard. While this 
tool doesn’t guarantee an accessible document, it walks the user through many of the tools outlined above. It 
is recommended to check the quality of the automated tagging afterwards using the Touch Up Reading 
Order tool.  

To use the Make Accessible wizard: 

1. In the right-side pane, expand the Action 
Wizard menu and select “Make Accessible.” 

 
2. The right-hand pane will shift to the Make 

Accessible menu. Select Start to begin. 
3. On the next screen, input a title in the Title 

field, and select OK.  
4. On the next screen, ensure the correct 

language is selected and click OK. 
5. Select whether or not to detect fillable form 

fields.  
6. Ensure the correct language is selected and 

click OK. 
7. Enter the correct alternative text for each 

image and click the right arrow to move 
through all the images. If the image is 
decorative, select Decorative Figure. 

8. On the Accessibility Checker Options 
screen, select Start Checking. 

9. Verify the tags are accurate using the Touch 
Up Reading Order tool and then work 
through the remaining accessibility errors 
mentioned in the Accessibility Checker 
report.  
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Tagging Tables 

1. Using the Touch Up Reading Order (TURO) 
tool, select the table and select Table from 
the TURO tool.  

 

2. Acrobat will automatically detect the cells contained within your table and tag them accordingly. The 
logical read order of most tables is row by row, so we want the cells to count across the row and then 
continue on the next line.  

 

Note: This table is likely to cause a regularity error as the blank cells in the lower row have been left untagged, 
causing Acrobat to perceive an inconsistent number of cells in each row.  
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Table Headers 

Like other documents, tables within PDFs require Column and Row header tags to allow for greater 
accessibility.  

To add table headers: 

1. With the TURO Tool open, right click within a table and select “Table Editor.” The table editor displays 
an overlay in which table headers are shaded red and all table data cells are gray. 

2. Right click a gray cell that should be a header cell. In this example, that would be Column 1, Row 2 
“Alcohol in 30 days.” Select Table Cell Properties. Note: You can also drag to select multiple cells at 
once. 

3. In the Table Cell Properties menu, select 
Header Cell and set the corresponding 
scope. In this example, it is a Row header.  

 

 

4. Repeat as necessary for the remaining header and data cells. 
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Tables in the Tags Panel 

As with all vital content, tables within a PDF must be tagged and appear within the Tags Panel. The tags 
associated with a table include: 
 

TYPE AS DISPLAYED IN TAGS PANEL 
TABLE <Table> 
TABLE ROW <TR> 
TABLE HEADER CELL <TH> 
TABLE DATA CELL <TD> 

 
The above table would appear like this in the Tags Panel: 

• <Table> 
o <TR> 

▪ <TH> 

• TYPE 
▪ <TH> 

• AS DISPLAYED IN TAGS PANEL 
o <TR> 

▪ <TH> 

• TABLE 
▪ <TD> 

• <Table> (not as a tag, but the content of the cell) 
o <TR> 

▪ <TH> 

• TABLE ROW 
▪ <TD> 

• <TR> (not as a tag, but the content of the cell) 
o <TR> 

▪ <TH> 

• TABLE HEADER CELL 
▪ <TD> 

• <TH> (not as a tag, but the content of the cell) 
o <TR> 

▪ <TH> 

• TABLE DATA CELL 
▪ <TD> 

• <TD> (not as a tag, but the content of the cell) 
 
If a table has an inconsistent number of cells per row or column, it will be flagged within the Accessibility 
Checker as having a Regularity Error.  
 
Note: When using the Touch Up Reading Order tool, or the automatic tagging tools, Acrobat will occasionally 
misunderstand the boundaries of a cell and split it into multiple cells in the tag tree. When this happens, you 
can either use the Cell option in the TURO tool to reunite the content, or drag the content segments into the 
same <TD> or <TH> tags.  
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Tagging Lists 

Tagging lists within Adobe Acrobat can be time consuming. If possible, it is recommended to ensure a true list 
was created within the source document, and then export it as a tagged PDF. 

The Touch Up Reading Order tool does not allow for lists to be tagged, so they must be manually tagged using 
the Tags Panel. The tags involved in list creation are: 

TYPE AS DISPLAYED IN TAGS 
PANEL 

PURPOSE 

LIST <L> The overarching list tag 

LIST ITEM <LI> Signify a specific list item/row 

LIST ITEM LABEL <Lbl> Often a bullet point or number. Note, this is 
not available as an option when adding tags 
and must be typed into the Type field. 

LIST ITEM BODY <LBody> The content of the list item 

 
 
 
 
Example List: 
 

1. Monday 
2. Tuesday 
3. Wednesday 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

As it would appear in the Tags Panel: 
 

• <L> 
o <LI> 

▪ <LBL> 

• 1 
▪ <LBody> 

•  Monday 
o <LI> 

▪ <LBL> 

• 2 
▪ <LBody> 

• Tuesday 
o <LI> 

▪ <LBL> 

• 3 
▪ <LBody> 

• Tuesday 
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Creating Fillable PDF Forms 

Creating a fillable form within Acrobat enables those users with disabilities to complete the form using 
assistive technology such as a screen reader.  

Most PDF forms are initially designed within Microsoft Word and then imported into Acrobat Pro. Forms 
designed this way should have implied fields within Microsoft Word. These may be blank spaces, blank lines or 
check boxes as shown below.

 

This source document should be exported to PDF much like other PDF documents.  

Once the document has been imported into Acrobat Pro, we will want to add form fields, add labels to the 
form fields, tag the form fields and then run the Accessibility Checker. 
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Adding Form Fields 

1. In Acrobat Pro, in the right-side Tools 
section, select the Forms menu and then 
select Create. 

 

 

2. Select From Existing Document, click Next, 
then ensure Current Document is selected. 
Click continue.  

3. Acrobat will attempt to automatically detect where the fields should be located. Sometimes extra 
fields are included along page breaks etc, so make your way through the document deleting erroneous 
fields. To delete a field, select it and hit the delete key. 

If some fields haven’t been automatically included, they will need to be manually added. This can be done 
using either the top toolbar or the Add New Field menu.  

 

Form Field Types  

The most commonly used field types are: 
 

• Text Field – Used for basic text, such as 
entering a name or address etc. 

• Check Box – Used to allow a selection or 
multitude of selections. 

• Radio Button – Much like a check box, but 
only one option can be selected.  

• Digital Signature – Used to enable 
signatures on a document.  

• Dropdown list – Allows a user to select one 
of many options. 

• List Box – Allows a user to select multiple 
options using the shift or control keys.  
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Add Labels to Form Fields 

The form fields property menu (accessed by right 
clicking a form field and selecting properties) offers 
both a Name and Tooltip field. The Tooltip field is 
the one that will be read to a screen reader user 
when filling the form, and it must contain all 
information needed to complete the field.  

All the Tooltip fields can be checked/filled quickly 
by filling in the fields, and then rather than closing 
the Field Properties menu, clicking the next form 
field.   

 

Add Tags to Fields 

Like other content within a PDF, form fields must be tagged to be accessible. If the PDF is untagged, running 
the automated tagging tool will tag them. To tag fields in an already tagged document: 

1. Leave the form editing tool by clicking Close 
Form Editing. 

 
2. In the Accessibility Tools menu, select Add 

Tags to Form Fields. This tool title implies it 
will add tags to all form fields, but it 
somehow falls short. We’ll have to tag the 
rest of the fields manually.   

 
3. Go the to the tags menu in the left-hand 

toolbar. Select the Options menu and then 
select Find.  
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4. In the Find menu, select “Unmarked 
Annotations” from the drop-down menu. 
Select Search Document and then click Find. 

 

5. An untagged form field will be selected. Select Tag Element.   
6. A New Tag window will appear. Select Form 

from the Type menu, and enter a name into 
the Title field (this title field will later 
appear in the tag tree). Select OK. 

 

7. The next untagged form field will be selected. Repeat steps 5&6 until all form fields are tagged. 

 

 

After tagging all of the form fields, the tag tree will 
likely need to be corrected as well as the form tags 
will be added at the end.  

 

If the PDF has already been tagged, drag and drop these form elements into the correct order, nesting tags 
alongside their corresponding content.  

 
Figure 1 - Correctly nested form fields 

If the PDF is not yet tagged, tags can be added using the automated Add Tags to Document tool. 

After placing the tags in a logical reading order, it is best practice to run the Accessibility Checker and repair 
any lingering issues. 
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Helpful Hints for Creating PDF Forms 

Multi-line responses 

A text box can accept multi-line responses. To enable this option: 

1. Go to the Form editing mode (Tools > Forms > Edit). 
2. Right click the form field you would like to accept multi-line responses and select Properties. 
3.  Go to the options tab and select Multi-line. 

Uniform field sizing and spacing 

Form fields can be set to match the size, horizontal alignment, or vertical alignment   of other fields.  This can 
be helpful when building a complex form within a table. Simply highlight the cells you would like to edit, right 
click the cell with the desired property, right click and select: 

• Align, Distribute or Center / Align vertically or Align horizontally 

• Set fields to the same size

Accessibility Checker Errors & Solutions 

Below are some of the more common Accessibility Checker errors and solutions. After repairing an issue, it is 
important to right click the error and select Check Again to update the Accessibility Checker results. 

Document 

Image-only PDF – Failed 

This is generally caused by the document being a scanned file. If possible, access the original source document 
and export it as a tagged PDF. If this is not possible, use the Text Recognition tool to have Acrobat identify text 
within the document.  

Tagged Content – Failed 

An untagged document will not be accessible. Tags may be added automatically using the Add Tags to 
Document tool, or manually using the Touch Up Reading Order tool. 

If the document is tagged, but this error is still received, there may be untagged content such as empty line 
breaks. Use the TURO tool to either tag the content, or mark it as background only.  

Logical Reading Order – Needs manual check 

This alert is simply reminding you to be aware of the reading order of the document. To verify it is correct, go 
to the Tags Panel and select the top tag. Then, using the arrow keys, move down the tag tree. Acrobat will 
highlight the elements as their tags are selected. If an element is out of order, simply drag and drop it into the 
right order in the tag tree.  

When you are satisfied the reading order is correct, you may right click the error and select Pass. 

Bookmarks – Failed 

Longer documents require bookmarks to enable screen reader users to skim through a document. When 
receiving this error: 

1. Right click the error and select Fix. 
2. In the Structure Elements box, select the type of tag you want to base the bookmarks off of. This is 

generally a heading tag, but will be dependent upon your document structure.  
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Title – Failed 

The title field of a document allows the screen reader user to hear the title as they enter a document. To fix 
this error, follow these steps:

1. In the Accessibility Checker pane, select “Title – Failed.” 

2. Right click and select “fix.” This will apply your document’s filename to the document. 

If you would like a different document title: 

1. Click File > Properties 

2. Enter a title into the “Title” field and click 
OK.  

 

Color Contrast – Needs manual check 

Similar to the error above, Acrobat is requesting you to review the contrast ratios of your document. Once you 
are certain there are no contrast issues, you may right click the error and select Pass.  

Primary Language – Fix 

The primary language of a document is important, as it tells the screen reader which language and 
pronunciation to use. If you are seeing “Primary language – Failed” in your Acrobat accessibility checker, 
follow these steps to repair it: 

1. In the Accessibility Checker pane, select 
“Primary language- Failed” 

2. Right Click and select “Fix.” 

  

3. Acrobat will attempt to detect the 
document language. If it is incorrect, select 
the language from the drop-down. 

4. Click ok.  
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Page Content 

Tagged Content – Failed 

This error is caused by content being left out of the tagging structure. To remedy this: 

1. Select each element. Acrobat will highlight the untagged content. Note: Sometimes the highlighting 
misses the actual content. 

2. Using the TURO tool, select the untagged content and apply a tag.  
3. Move down the list and tag each piece of content accordingly. 
4. Right click the error and select Check Again. 

Tab order – Failed 

Right click the error and select Fix. This will set the form tab order of the document to match the tag tree.  

 

Alternative Text 

Figures alternative text – Failed 

1. In the Accessibility Checker, expand 
“Alternate Text”, then “Figures alternate 
text – Failed”, then select “Figure 1”. The 
corresponding figure will highlight.  

 

2. Right click “Figure 1” in the Accessibility 
Checker, and select “Fix.” A pop-up window 
will appear. Enter the Alternative text, or 
select “decorative figure”. 

 

3. If there are multiple errors, select the right 
arrow and make your way through them, 
adding text as required.  

4. When you are done, click “Save & Close.” 
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Tables 

Rows – Failed 

This error is caused by a row tag (<TR>) existing outside of a Table tag (<Table>) within the tag tree. Ensure all 
<TR> tags are nested within a table tag. 

TH and TD – Failed 

Similar to the Rows error, this is caused by Table Data Cell (<TD>) and Table Header Cells (<TH>) existing 
outside of a row and table tag. Ensure all cell tags are nested within a row (<TR>) and table (<Table>) tag. 

Summary - Failed 

Table summaries are text that provide additional guidance to screen reader users on how to use the table. To 
include them: 

1. Select the Touch Up Reading Order tool. 
2. Right click the table and select Edit Table Summary. 
3. Enter the appropriate table summary into the field. 

Regularity – Failed 

The regularity error is caused by there being an inconsistent number of cells in each row. This is generally 
caused by a blank cell not being detected and included within the Tags Panel.  

To repair this:  

1. Right click the error in the Accessibility Checker and select Show in Tags Panel. 
2. Expand the table (<Table>) & table row (<TR>) tags.  
3. Count the number of Table Header (<TH>) and Table Data Cell (<TD>) tags contained within each table 

row. These should be consistent throughout the table, but as the regularity error has been received, it 
is likely not.  

4. Right click the cell above where a cell is missing and select New Tag. Select either “Table Data Cell” or 
“Table Header Cell.” A blank cell tag will be inserted. Repeat as necessary.  

5. Go back to the Accessibility Checker results, right click the Regularity – Failed text and select Check 
Again. 

If all rows have a consistent number of cells, but a regularity error still occurs, the table may benefit from 
being tagged with <THead> and <TBody> tags: 

1. Right click within the Tags Panel within the <Table> tag and select New Tag. Type THead in the Type 
field.  

2. Drag the THead tag above the first row. 
3. Drag the first row into the THead tag. 
4. Right click below the THead tag and select New Tag. 
5. Type TBody in the Type field. 
6. Drag all remaining rows into the TBody tag.  
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The resulting THead and TBody tags should be nested as: 
 

• <Table> 
o <THead> 

▪ <TR> 

• <TH>  

• <TH> 
o <TBody> 

▪ <TR> 

• <TH> 

• <TD> 
▪ <TR> 

• <TH> 

• <TD>

Headings 

Appropriate Nesting – Failed 

This is caused as headings must be nested. Headings should be nested as such, with H1 being the document 
title: 

• H1 
o H2 
o H2 

▪ H3 
o H2 
o H2 

▪ H3 

• H4 
o H2 

 

Use the Tags Pane or Touch Up Reading Order tool to correctly nest the headings.  

If nesting the headings in this way does not remove the error, there may be an empty heading tag in the tag 
tree. Expand the error, select an element, right click it and select “Show in Tags Panel.  
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